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General Information and Imager Specifications For More Information...
DataMan 60 is a compact fixed-
mount ID reader that among 
others offers the following 
advanced features:

•	 Smallest high-performance 
fixed mount reader

•	 Highest read rates for 1-D and 
2-D codes

•	 Reliability and image feedback

DataMan 60 readers support RS-232, USB, and Ethernet interface connections 
plus discrete I/O.

The DataMan 60 reader is packaged in an IP40-rated housing.

This document provides basic information about how to configure and 
use the DataMan 60 reader. Additional information is available through 
the Windows Start menu or the Setup Tool Help menu after you install 
the DataMan software on your PC:

DataMan Fixed Mount Readers Reference is a complete 
online hardware reference for the DataMan reader. 
Cognex->DataMan Software v x.x->Documentation->English->DM60->Fixed Mount 
Reference Manual

DataMan Communications & Programming Guide shows 
how to integrate your DataMan reader with your automation 
software and factory network.
Cognex->DataMan Software v x.x->Documentation->Communications &
Programming

DataMan Reader Configuration Codes provides printable 
2-D codes that you can use to configure the DataMan reader.
Cognex->DataMan Software v x.x->Documentation->English->Reader Configuration 
Codes

DataMan Questions and Answers provides context-sensitive 
information. You can view this help inside the Setup Tool or as 
a stand-alone help file.
Cognex->DataMan Software v x.x->Documentation->English->DM60->Questions and 
Answers

Release Notes list detailed system requirements and 
additional information about this DataMan software release.
Cognex->DataMan Software v x.x->Documentation->DataMan v x.y.z Release Notes

Specification DataMan 60 Imager

Image Sensor 1/3 inch CMOS

Image Sensor Properties 4.51 mm x 2.88 mm (H x V), 6.0 µm square 
pixels

Image Resolution 
(pixels)

752 x 480

Electronic Shutter Speed 18 µs to 25 ms exposure

Image Acquisition up to 60 fps at full resolution

Lens Type 3 focal position M12 lens



The following image shows the characteristics of the DataMan 60 reader.
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DataMan 60 Systems

Aimer LED

Internal 
illumination

3-position 
lens cap

External 
illumination 
connector

Omni-directional 
1-D Code Reading

IDQuick™ — 

Well marked 2-D Code 
Reading

1DMax+™ with 
HOTBARS™ 

DataMan 60L 
(DMR-60L-00) √

DataMan 60QL 
(DMR-60QL-00) √ √

DataMan 60S* 
(DMR-60S-00) √ √ √

*S: Maximum decode rate of 5 codes / sec

Lens

Focal position 
indicator

Status LEDs

DataMan 60 Reader Layout

•	 Power: YELLOW = Power ON
•	 Communication: Flashing YELLOW 
•	 Good/bad read: GREEN = good read / RED = bad read
•	 Error: RED = error, check device log
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Ethernet 
RJ-45 
connector

Directly 
connected cable 
terminating in a 
DB15 connector 
providing: power, 
I/O, USB, and RS-
232 connectivity

mounting 
points

DataMan 60 Accessories

10

8

11

9

USB Cable, 1.5 m 
(DM100-USB-000)

1

2

CABLES

9

RS-232 Cable, 1.5 m 
(DM100-RS232-000)

MOUNTING BRACKETS

POWER SUPPLY

Pivot Mounting Bracket 
(DM100-PIVOTM-00) 

Power Supply, 6V 
(DM100-PWR-000)

7

4

USB Cable, 3 m 
(DM100-USB-030)

5

Extension Cable, 5 m 
(DM100-EXTCBL-000)

6

10

3

11

RS-232/USB adapter connector 
(DM100-PATCH-000)

USB & Flying Leads I/O Cable, 2.0 m 
(DM-USBIO-00)

RS-232 & Flying Leads I/O Cable, 2.5 m 
(DM-RS232IO-00)

1

2

7

3

4 5

6

8 Ethernet Cable: use any standard 
CAT5/5e, SF/FTP or S/FTP cable 

DataMan 60 Reader Layout (Continued)

Universal Mounting Bracket  
(DM50-UBRK-000)
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DataMan 60 can operate in one of three distance ranges. To set the 
focus position:

Remove lens cover.

Setting the Focus Position

1

2 Set focus position to 45, 70, or 110. Turn the lens cap clockwise   
(45->70->110) for larger focus settings; turn the lens cap counter-
clockwise (110->70->45) for smaller settings.

3 Reattach the front cover.

DataMan 60 Accessories (Continued)

DOCUMENTATION AND INSTALLER
DataMan 60 Quick Reference Guide 
(this document) (590-7166) 

CONTROL BOX
Control Box (DM-CTRLBOX-00) 12

13

DataMan 5.1 Thumb Drive 
(DMA-USBST-510) 

14

12

13

14
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36 mm (1.4 in)
56 mm (2.2 in) 

80 mm (3.15 in)

6 mil 33-51 mm  (1.2-2 in)

8 mil 31-57 mm  (1.2-2.2 in)

10 mil 27-60 mm  (1-2.3 in)

4 mil 34-51 mm (1.3-2 in)

6 mil 30-56 mm (1.1-2.2 in)

2-D

1-D

45 mm
12 mil 25-61 mm  (0.9-2.4 in)

10 mil 37-66 mm (1.4-2.5 in)

This chart shows the horizontal field of view for the DataMan 60 at a range of 
working distances, together with the supported range of reading distances at 
45 mm focus position.
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70 mm 2-D
6 mil 44-74 mm  (1.7-2.9 in)

8 mil 42-78 mm  (1.6-3 in)

10 mil 39-80 mm

12 mil 34-89 mm

  (1.5-3.1 in)

  (1.3-3.5 in)

1-D
4 mil

6 mil

10 mil

52-73 mm

45-83 mm

33-89 mm

 (2-2.8 in)

 (1.7-3.2 in)

 (1.2-3.5 in)

This chart shows the supported range of reading distances at 70 mm 
focus position.
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Field of View and Reading Distances



100mm

in

0

0 3

200

6

20 40 60 80 120 140 160 180

1 2 74 5

10 mil 58-121 mm  (2.2-4.7 in)

12 mil 54-133 mm  (2.1-5.2 in)

6 mil 66-122 mm (2.5-4.8 in)

2-D

1-D

110 mm

58-168 mm (2.2-6.6 in)

10 mil 50-141 mm (1.9-5.5 in)

15 mil

The following table shows the Field of View widths in mm at various distances.

distances in 
mm

DM50

45 36

70 56

110 80

Field of View and Reading Distances (Cont.)
This chart shows the supported range of reading distances at 110 mm focus 
position.

Observe the following DataMan 60 reader dimensions when installing 
your reader.

 31.75mm
1.25in

  40.96mm
1.61in

 

 53.61mm
2.11in

 

 29.71mm
1.17in

 

 4.61mm
0.18in

 

 23.90mm
0.94in

 

 23.61mm
0.93in
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Dimensions



 31.75
1.25

 

 40.96
1.61

 

 53.63
2.11

 

 23.61mm
0.93in

 

The attachment points have the following characteristics:

•	 M3 thread
•	 Maximum thread depth: 6 mm
•	 1.3 N-m (11.5 in-lb) maximum torque

Caution: Use both attachment points when mounting your device.

TIP: Some applications can benefit from mounting the system at a slight angle 
(15 degress) to reduce reflection from the inspected surface back to the reader.

 31.75 m
m

1.25”

 
 45.40 m

m

1.79”

 

 

 

 27.40 m
m

1.08”

 

 21.65 m
m

0.85”

 

 23.44

0.92

 

 750mm

29.5in

CONNECT YOUR READER

1.	Connect the cable on the back of the device to either an USB 
adapter cable with power tap or to an RS-232 adapter cable with 
power tab.

2.	Connect a 6V power supply.

3.	Connect the reader to an Ethernet network.
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Dimensions (Continued) Installing DataMan Software and 
Connecting the Reader
INSTALL DATAMAN SOFTWARE AND CONNECT

1.	Check the DataMan Release Notes for a full list of system 
requirements. 

2.	 Insert CD-ROM and follow the on-screen prompts until you 
successfully completed the DataMan Software installation process.

3.	Connect the DataMan 60 reader to your PC. 

4.	 Launch the Setup Tool and click Refresh.

Detected readers will appear under the COM ports or Network 
devices.

5.	Select a reader from the list and click Connect. 



IN1 
button
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Start the Setup Tool
Trigger 
button

Connect the reader to the Setup Tool to configure it with 
the type of symbologies it will decode as well as other 
parameters, such as the type of trigger it will use and the 
format of the results it will generate.

Alternatively, configure your reader by scanning the 
appropriate reader configuration code from the Reader 
Configuration Codes document, available through the 
Windows Start menu.

Quick Setup
All main controls and visual feedback in a single view, for 
easiest setup and configuration

Connect to Reader
Establish a connection to the reader

Results Display
View results

Light and Imager Settings
Choose a trigger type and other acquisition parameters

System Settings
Configure visual and audio feedback, trigger and output 
actions

Table View
See all the selectable values in the Setup Tool in one table

Latest image

Read history

Context based help

Connection status

Region of interest

Train 
status

Code 
information
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Troubleshooting an Ethernet Connection
Based on your network configuration, the Setup Tool may not be able to 
communicate with the reader and it will not appear in the list of Network 
devices. 

First check your Ethernet connection with the reader and click Refresh in the 
Setup Tool. Next, scan the Enable DHCP code in the Reader Configuration 
Codes document available from the Start menu. This might allow the reader to 
acquire a suitable IP address from a DHCP server on your subnet. 

If the reader still does not appear, you can use either the Add Device or Force 
Network Settings options in the Setup Tool. 

If you know the IP address of the reader, use the Add Device option. If you 
do not know the IP address, use the Force Network Settings options. Either 
method should allow the DataMan 60 reader to appear in the list of Network 
devices so that you can connect to it through the Setup Tool and your 
Ethernet connection.

You can also use the RS-232 connection to configure the reader with 
parameters that allow it to communicate over your Ethernet network. 

Industrial Protocols
The DataMan 60 supports the following industrial protocols:

•	 EtherNet/IP™
•	 PROFINET
•	 MC Protocol
•	 Modbus TCP

There are three ways to enable or disable Industrial Protocols. Using 
either method, a reboot is required for the changes to come into effect.

•	 Enable the protocols using the Industrial Protocols pane of the 
Setup Tool (under Communication Settings).

•	 Scan the appropriate Reader Configuration codes (see Reader 
Configuration Codes available through the Windows Start menu or 
the Setup Tool Help menu).

•	 Send the appropriate DMCC (see Command Reference available 
through the Windows Start menu or the Setup Tool Help menu).

For more information on using the industrial protocols, read the 
DataMan Communications and Programming Guide available through 
the Windows Start menu or the Setup Tool Help menu.

Select industrial 
protocol samples and 
tools you want to use 
when you install the 
DataMan Software.
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Use the Setup Tool Menu Bar
The In1 button on the toolbar creates a virtual rising edge signal on Input 
1. Use the In1 button to activate various actions such as training a code, 
optimizing brightness or setting a match string without a physical input 1 
channel.

Each reader can store its current set of runtime parameters to a configuration 
(.cfg) file, which contains information such as the enabled symbologies and 
how any output data should be formatted. 

The same configuration file can be loaded onto multiple readers, as the file 
does not contain identification information such as the IP address or device 
name of the reader used to create it.

A reader can also generate a Cognex device configuration (.cdc) file, which 
stores the set of runtime parameters plus any identification data, such as 
the name of the device, its IP address, subnet mask, and so on. Cognex 
recommends generating a device configuration file for each reader to allow you 
to restore a reader to its operating state with minimal effort. 

Use the File menu of the Setup Tool to manage .cfg and .cdc files, export 
parameters, or to load, save, or train uploaded images.

File Menu

Open Configuration Open a saved .cfg configuration file. 

Save Configuration Create a .cfg configuration file of current 
runtime parameters. 

Restore Device Load a saved device configuration .cdc 
file, with run-time parameters plus 
device-specific information for a particular 
DataMan reader. 

Backup Device Create a device configuration .cdc file for a 
specific reader. 

Export Parameters Save (all or only the non-default) 
parameters of your device in a text file.

Load Image Load an 8-bit uncompressed grey-scale 
.bmp or .jpg image for analysis.

Save Image Save the latest acquired image with the 
.jpg or .bmp file format.

Save Burst Images Save the latest batch of burst images.

Train Image Upload an image to be used for training.

Use the Edit menu for standard Cut, Copy and Paste operations. 

Use the View menu to view reader information (serial number, firmware 
version, and so on) and to enable and disable various elements of the 
Setup Tool, and the Tasks menu to switch between various Setup Tool 
options. 
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System Menu

Save Settings Save the current parameters to non-volatile memory, 
which allows the reader to restore these settings 
each time you reboot it.

Reset Configuration Reset all configuration parameters in RAM (volatile 
memory) to the default settings. 

Update Firmware Update the reader software.

Upload Feature Key Unlock additional features available in the reader 
software if you have the right key.

Show Device Log Error and exception conditions, such as missed 
triggers and trigger overruns are logged.

Delete Device Log Clear your device log.

Use the Help menu to display Setup Tool version information. 

Use the System menu to manage the current settings on the reader and to 
upgrade the features it currently supports: 

Use the Setup Tool Menu Bar (Continued) DataMan 60 Triggering
DataMan 60 readers support the following trigger modes: 
•	 Self: At an interval you configure, the reader automatically detects 

and decodes codes in its field of view. If you set a higher re-read 
delay than the trigger interval, there is a code output only once until 
the code is out of the field of view for the duration of the re-read 
delay.

•	 Single (external trigger): Acquires a single image and attempts to 
decode any symbol it contains, or more than one symbol in cases 
where multicode is enabled. The reader relies on an external trigger 
source. 

•	 Presentation: Scans, decodes and reports a single code in the field of 
view. The reader relies on an internal timing mechanism to acquire 
images. 

•	 Manual: Begins acquiring images when you send an external trigger, 
and continues acquiring images until a symbol is found and decoded 
or you stop the external triggering.

•	 Burst: Performs multiple image acquisitions based on an external 
trigger and decodes any symbol appearing in a single image or within 
a sequence of images, or multiple symbols in a single image or within 
a sequence of images when multicode is enabled. You can control the 
number of images within each burst and the interval between image 
acquisitions.

•	 Continuous: Begins acquiring images based on a single external 
trigger and continues to acquire and decode images until a symbol 
is found and decoded, or until multiple images containing as many 
codes as specified in multicode mode are located, or until the trigger 
is released. You can configure your reader to acquire images based 
on the start and stop signal from separate digital IO pulses.
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External Triggers
If you are using external triggering you can use any of these methods to 
trigger your DataMan 60 series reader:
•	 Send a pulse on the I/O cable:

•	 Input 0 (white)

•	 Input 1 (white/black)

•	 Send a serial trigger command over the RS-232 connection or 
Ethernet connection.

•	 Press <CTRL>-T on the keyboard while the Setup Tool has the input 
focus.

•	 Click the Trigger button in the Setup Tool: 
 

Multi-Reader Triggering
For trigger modes other than Presentation, the DataMan 60 supports 
multi-reader triggering, also known as master-slave configuration. 
In this configuration, you configure multiple DataMan readers as a 
group. Whenever any reader in the group is triggered, all the readers 
are triggered and the results from all the readers are assembled and 
transmitted by a single reader that you designate as the master.
Multi-reader triggering is used to support extended field of view reading 
and reading codes from multiple product surfaces:

To configure multi-reader triggering, select the Master/Slave pane in 
the Setup Tool (under System Settings). For more information, see 
the DataMan Fixed Mount Readers Reference.



28  DataMan 60 Quick Reference Guide DataMan 60 Quick Reference Guide   29

Training the Reader
Training your reader with the expected symbology can make the time required 
to decode successive symbols more consistent. In addition, training may help 
increase decode yield. 

To train your reader, place a code in front of the reader and do one of the 
following: 

•	 Click and hold the trigger button in 
the Setup Tool for a minimum of 3 
seconds. 

•	 Click Train Code in the Results Display pane. 

You can use training in Single, Burst, Continuous or Self trigger modes.

NOTE that only a single symbol of each symbology kind can be trained.

•	 Upload the code through File menu  Train Image.

Incremental Training for Multiple Symbologies
If you want to train the reader to recognize multiple symbologies, you 
can present a single image showing all the desired symbologies and 
perform the training procedure previously described. 

If you cannot present a single image showing all the necessary 
symbologies, you can enable incremental training on the Training tab 
of the Symbology Settings pane: 

With incremental training enabled, you can train the reader using 
multiple images showing the symbologies you expect to decode. The 
reader will train each new symbology while retaining the existing trained 
symbologies.  



Read Setups

Your reader can be configured for up to 16 different settings. In Single trigger 
mode, you can enable multiple (or all) setups, and the DataMan 60 reader 
goes through all of the configured imager combinations until there is a decoded 
image or there are no images left (that is, a no read image).
You can change the parameters for the setups either on its dedicated pane, 
or in the Read Setup pane’s appropriate table cell. Whatever you change on 
either pane is mirrored on the other.
The read setup process starts with either a specific setup, or the Last 
Successful Decode (as you choose).

It is possible to configure a variety of acquisition parameters for your DataMan 
60 reader on a unified Read Setups pane. 

The currently selected setup also gets represented on other panes. 

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

PIN Color Signal
1 Brown Reserved

2 Green TxD

3 Green/Black RxD

4 Red and Brown/
White

GND

5 Red/Black DC+ (system power, 
5-24 VDC)

6 Blue RTS

7 Blue/White Output-0

8 White Input-0

9 White/Black Input-1

10 Light Blue CTS

11 Light Blue/Black Output-1

12 Light Blue/Yellow Output-Common

13 Light Blue/Green Output-Strobe

14 Yellow Reserved

15 Yellow/Black Reserved
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I/O Cable
The I/O cable provides access to trigger and high-speed outputs. Unused wires can 
be clipped short or tied back using a tie made of non-conductive material. 

For RS-232, use the Power Supply return path for ground.

NOTE: GND (Pin 4) is connected to the reader housing, cable shield, and DB15 
shell.
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1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

PIN Color Signal

4 Black GND

7 Blue/White Output-0

8 White Input-0

9 White/Black Input-1

11 Light Blue/Black Output-1

12 Light Blue/Yellow Output-Common

13 Light Blue/Green Output-Strobe

You can connect a cable with USB & flying leads to the cable that is attached 
to the device. The following table shows the pinout and color description of the 
flying leads.

USB & Flying Leads I/O Cable

This is a female 
connector/socket.

RS-232 & Flying Leads I/O Cable

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

PIN Color Signal

4 Black GND

5 Brown/White VDC

7 Blue/White Output-0

8 White Input-0

9 White/Black Input-1

11 Light Blue/Black Output-1

12 Light Blue/Yellow Output-Common

13 Light Blue/Green Output-StrobeThis is a female 
connector/socket.

You can connect a cable with RS-232 & flying leads to the cable that is 
attached to the device. The following table shows the pinout and color 
description of the flying leads.



Digital Input Lines
Inputs are not galvanic isolated but need to be referenced to ground.

Input-0/Input-1 

ESD Protection 
Constant 2mA
current sink

Input-Internal-1/
Input-Internal-2
(Internal Signals)

+Vdd        DM60 sinking

       OUT

       PLC

       COM        +  -

External Wiring Examples: Digital Input 
Lines

34  DataMan 60 Quick Reference Guide DataMan 60 Quick Reference Guide   35



External Wiring Examples: Digital Input 
Lines (Continued)

       NPN
       DM60

       PNP
       DM60

Digital Output Lines
The digital outputs can be used as either NPN (pull-down) or PNP (pull-
up) lines. For NPN lines, the external load should be connected between 
the output and the positive supply voltage (<24V). The outputs pull 
down to less than 3V when ON, which causes current to flow through 
the load. When the outputs are OFF, no current flows through the load. 
Outputs are not galvanic isolated but need to be referenced to ground.

Output_Common

Output_IOPTC
DSP output
    signal 50mA

NPN (pull down) output type characteristics are the following:

Applied voltage 24 VDC or less

Residual voltage 0.85V or less 

Maximum sink current 25mA

Short-circuit current 100mA or less

Short-circuit protection multifuse - 50mA
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PNP (pull up) output type characteristics are the following:

Output voltage range 24V or less

Residual voltage 0.8V or less 

Maximum source current 25mA

Short-circuit current 50mA or less

Short-circuit protection multifuse - 50mA

Digital Output Lines (Continued) External Wiring Examples: Digital Output 
Lines

       DM60

       PLC

       DM60

       PLC

       50 mA

       Output 
       Common

       Output 0,1 

       Output Common

       Output 0,1        50 mA

NPN
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External Wiring Examples: Digital Output 
Lines (Continued)

       DM60        PLC

       DM60

       PLC

       50 mA

       50 mA

       Output 
       Common

       Output 0,1 

       Output Common

       Output 0,1 

PNP

Illumination Strobe Output
The strobe output is provided by a diode that is added to the push-pull 
circuit, with series to the pull-up transistor. This diode blocks the higher 
voltage when the output is pulled up when used as open-collector type 
driving, but enables the driving of high level in TTL mode.

TTL output type characteritiscs are the following:

High level 4.0-5.0V

Low level 0-0.4V

Output current 25mA

Short-circuit current 125mA

Short-circuit protection multifuse - 50mA

Open-collector output type characteristics are the following:

Output voltage range 0-24V

Low level 0-0.4V

Output current 25mA max

Short-circuit current 125mA

Short-circuit protection multifuse - 50mA
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The following figure shows the wiring diagram of the illumination strobe 
output.

+5VDC

Output-Strobe

ESD Protection
       Strobe 
(Internal signal)

Illumination Strobe Output (Continued)

       DM60

       LOAD
       50 mA

       DM60

       LOAD

       50 mA

External Load Strobe Output
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You can connect multiple DataMan 60 readers to a single PC (or other device 
equipped with a serial port) using a multi-port connection. 

A multi-port connection creates a daisy-chain of readers. Each reader receives 
serial data from the previous reader and transmits it to the next reader. When 
a reader transmits data, it is passed through each of the readers in the chain 
between it and the PC. 

Because of the large number of possible configurations, Cognex does not 
supply cabling for multi-port DataMan 60 connections. Instead, you must 
construct your own cable that meets the requirements of your system 
configuration.
The cable must provide a DB-9 connector for each DataMan 60 serial cable and 
a DB-9 connector for the PC serial port. Each DB-9 connector must provide Tx 

Multi-Port Connections

2

3

5

532 532 532

DataMan 60

2: Tx Data
3: Rx Data
5: GND

2: Rx Data
3: Tx Data
5: GND

PC

DataMan 60 DataMan 60

Data, Rx Data, and ground. The Tx Data and Rx Data pins on adjacent 
connectors must be connected to provide the multi-port connection. 

The following diagram shows how to create a multi-port cable for a 
3-reader system:
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Configuring for Multi-Port Operation
You must connect the Setup Tool to each DataMan 60 in turn and enable multi-
port operation. Click the Communication Settings task and check the Enable 
Multi-Port (RS-232 Sharing) check box.

There is no guaranteed delivery order when multiple readers transmit data 
using a multi-port connection; read results may arrive at the PC in any order. 
You can configure each DataMan 60 reader in a multi-port connection to add 
identifying data to each read result. Your PC application can then determine 
which reader produced a specific read result.

To do this, click on the Data Formatting task, click the appropriate Standard 
box (for each symbology that you are using), go to the Standard Formatting 
pane, and enter text in the Leading Text field. (You can also add trailing text 
by entering text in the Terminating Text field.)

You can obtain the best results when using multi-port connections by 
keeping the following usage guidelines in mind as you design your 
system:

•	 The maximum cable length between any two DataMan readers or 
between the PC and any DataMan reader should be no greater than 
15 meters.

•	 There is no fixed limit to the number of DataMan readers that you 
can connect to a single PC. Each reader introduces a delay of about 
100 msec when it retransmits received serial data. If you have 5 
readers, this means that there will be a 400 msec delay between the 
time the first reader in the chain transmits data and the PC receives 
it.

•	 Each DataMan reader must receive a hardware trigger signal on its 
Input 0 line. You can wire the input ports to a common trigger signal 
or you can provide individual triggers for each reader.

•	 If any reader in the multi-port chain loses power or becomes 
disconnected, then no data from any other reader will be 
transmitted.

•	 If a DataMan is transmitting its own read result, it will buffer any 
data received from another reader until it has finished its own data 
transmission. If a DataMan reader is transmitting another reader’s 
data, it will buffer its own data if it receives a trigger signal while it is 
processing the other reader’s data. 

•	 If you use a single power supply for multiple readers, make sure that 
the power supply can provide enough power for all of the readers.

•	 You cannot connect a reader to the Setup Tool over RS-232 once 
multiport is enabled. You must first scan the Disable Multi-Port code 
from the Reader Configuration Codes, available from the Start menu. 

Multi-Port Usage Notes
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DataMan 60 Specifications 
Weight 76 g (including cable)

Operating Temperature 0ºC — 40ºC (32ºF — 104ºF)

Storage Temperature -10ºC — 60ºC (-14ºF — 140ºF)

Maximum Humidity 95% (non-condensing)

Environmental IP40

Vibration EN61373 including IEC 60068-2-6,60068-2-64 6.4, and 60068-2-27

Codes Data MatrixTM (IDMax: ECC 0, 50, 80, 100, 140, and 200; IDQuick: ECC200)
QR Code and microQR Code, MaxiCode

UPC/EAN/JAN
Codabar, Interleaved 2 of 5, Code 39, Code 128, and Code 93, Pharma, 

Postal, RSS/CS, PDF 417, MicroPDF 417

Discrete I/O 
operating limits

Output 0,1 IMAX        @ 24 VDC                25              mA
VMAX                                                                  24                V

Output 2 Source VTYP                                           4                  V

Sink VIH                                                       4 - VPSU             V
          VIL                                                   0 — 2           V 

Input 0 (Trigger)
Input 1

VIH                                                                  4 — 26         V
VIL                                                                    0 — 2           V
ITYP                                                                          3              mA           

Power Supply 
Requirements

VPSU                   4,5 —  24 VDC 
2.5 W maximum 
LPS or NEC class 2 power supply

Ethernet Speed 10/100

Duplex Mode Full duplex or half duplex

i NOTE: For product support, contact http://support.cognex.com

CAUTION: IP protection is ensured only when all connectors are 
attached to cables or shielded by a sealing cap. 

Warnings and Notices

CAUTION: LED RADIATION - DO NOT VIEW DIRECTLY WITH 
OPTICAL INSTRUMENTS - CLASS 1M LED PRODUCT
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DataMan 60 readers meet or exceed the requirements of all applicable stan-
dards organizations for safe operation. However, as with any electrical equip-
ment, the best way to ensure safe operation is to operate them according to 
the agency guidelines that follow. Please read these guidelines carefully before 
using your device.

Regulator Specification
USA FCC Part 15, Subpart B, 

Class A
European 
Commu-
nity

EN55022:2006 +A1:2007, 
Class A
EN55024:1998 
EN60950

FCC Class A Compliance Statement

 
This equipment has been tested and found to comply with the limits for a Class 
A digital device, pursuant to Part 15 of the FCC rules. These limits are designed 
to provide reasonable protection against harmful interference when the equip-
ment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio com-
munications. Operation of this equipment in a residential area is likely to cause 
harmful interference, in which case the user will be required to correct the 
interference at personal expense.

Compliance Statements
UL Statement

  
UL listed: UL60950-1 2nd ed. and CSA C22.2 No.60950-1-07 2nd ed.

European Compliance

  
The CE mark on the product indicates that the system has been tested 
to and conforms to the provisions noted within the 2004/108/EEC Elec-
tromagnetic Compatibility Directive and the 2006/95/EEC Low Voltage 
Directive. 

For further information please contact:
	 Cognex Corporation
	 One Vision Drive
	 Natick, MA 01760
	 USA

Cognex Corporation shall not be liable for use of our product with equip-
ment (i.e., power supplies, personal computers, etc.) that is not CE 
marked and does not comply with the Low Voltage Directive.

For European Community Users
Cognex complies with Directive 2002/96/EC OF THE EUROPEAN PARLIA-
MENT AND OF THE COUNCIL of 27 January 2003 on waste electrical and 
electronic equipment (WEEE).
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This product has required the extraction and use of natural resources for its 
production. It may contain hazardous substances that could impact health and 
the environment, if not properly disposed. 

In order to avoid the dissemination of those substances in our environment and 
to diminish the pressure on the natural resources, we encourage you to use the 
appropriate take-back systems for product disposal. Those systems will reuse 
or recycle most of the materials of the product you are disposing in a sound 
way.

The crossed out wheeled bin symbol informs you that the product should not 
be disposed of along with municipal waste and invites you to use the appropri-
ate separate take-back systems for product disposal.

If you need more information on the collection, reuse, and recycling systems, 
please contact your local or regional waste administration.

You may also contact your supplier for more information on the environmental 
performance of this product.

Compliance Statements (Continued)
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Reader Programming  Codes

Reset Scanner to 
Factory Defaults Reboot Scanner


